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VISION OF THE INSTITUTE

“To be World Class Institute for Social Transformation through Dynamic Education”

MISSION OF THE INSTITUTE

e To provide quality technical education with advanced equipment, qualified
faculty members, infrastructure to meet needs of profession and society.

e To provide an environment conductive to innovation, creativity,
research and entrepreneurial leadership.

e To practice and promote professional ethics, transparency and accountability
for social community, economic and environmental conditions.

VISION OF THE DEPARTMENT

“To pursue and excel in the endeavour for creating globally recognized computer
engineers through quality education”.

MISSION OF THE DEPARTMENT

1. To impart fundamental knowledge and strong skills conforming to a dynamic
curriculum leading to developing professional competencies and continuing intellectual
growth.

2. To develop professional, entrepreneurial and research competencies encompassing
continuing intellectual growth.

3. To strive for producing qualified graduates possessing proficient abilities and
ethical responsibilities adapting to the demand of working environment.

PROGRAM EDUCATIONAL OBJECTIVES

Graduates upon completion of B. Tech Computer Engineering Programme will able to:

1. Demonstrate technical and professional competencies by applying engineering fundamentals, computing
principles and technologies.

2. Learn, Practice, and grow as skilled professionals/ entrepreneur/researchers adapting to the evolving computing
landscape.

3. Demonstrate professional attitude, ethics, understanding of social context and interpersonal skills leading to a

successful career.
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PROGRAM OUTCOMES

1. To apply knowledge of computing and mathematics appropriate to the domain.

2. To logically define, analyse and solve real world problems.

3.To apply design principles in developing hardware/software systems of varying complexity that meet the
specified needs.

4.To interpret and analyse data for providing solutions to complex engineering problems.

5.To use and practise engineering and IT tools for professional growth.

6.To understand and respond to legal and ethical issues involving the use of technology for societal benefits.

7.To develop societal relevant projects using available resources.

8.To exhibit professional and ethical responsibilities.

9.To work effectively as an individual and a team member within the professional environment.

10. To prepare and present technical documents using effective communication skills.

11. To demonstrate effective leadership skills throughout the project management life cycle.

12. To understand the significance of lifelong learning for professional development.

GENRAL INSTUCTIONS:

» Equipment in the lab is meant for the use of students. Students need to maintain
a proper decorum in the computer lab. Students must use the equipment with care.

» Students are required to carry their reference materials, files and records with
completed assignment while entering the lab.

» Students are supposed to occupy the systems allotted to them and are not supposed
to talk or make noise in the lab.

» All the students should perform the given assignment individually.

» Lab can be used in free time/lunch hours by the students who need to use the
systems should take prior permission from the lab in-charge.

» All the Students are instructed to carry their identity cards when entering the lab.
» Lab files need to be submitted on or before date of submission.

» Students are not supposed to use pen drives, compact drives or any other storage
devices in the lab.

» For Laboratory related updates and assignments students should refer to the notice
board in the Lab.
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COURSE NAME: MOBILE COMPUTING

WEEKLY PLAN:

Week No.

Problem Definition

Practical/Assignment Name

To develop a Simple Android

Developing a Simple Android Application

receiving a message.

1 Application _that  uses  GUI that uses GUI components, Font and Colors.
components, Font and Colors.
To develop a Simple Android Developing a Simple Android Application
2 Application that uses Layout that uses Layout Managers and Event
Managers and Event Listeners. Listeners.
To develop a Simple Android _ _ _ o
3 Application for Native Calculator. | Developing a Simple Android Application
for Native Calculator.
To Develop android application . . " .
4 for spinning bottle game. Developing android application for spinning
bottle game.
To develop Android Application . . - .
5 for Rolling Dice Game D(_aveloplng Android Application for Rolling
Dice Game.
6 To develop android application Developing android application for Login
for Login Page. Page.
7 To develop android application Developing android application for web
for web application. application.
:IA-\O dﬁzgtlioopnir?;;n dpr[:wps\nbdarsﬁlcd Developing a Simple Android Application
8 ppiIc o that draws basic Graphical Primitives on the
Graphical Primitives on the
screen.
screen.
To develop a Simple Android . . . I
" Developing a Simple Android Application
9 Application that makes use of
Database. that makes use of Database.
10 To develop a Android Application | peyeloping a Android Application that
that creates Alarm Clock. creates Alarm Clock.
To develop a Android Application
11 that creates an alert upon Developing a Android Application that

creates an alert upon
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EXAMINATION SCHEME

Practical Exam: 25 Marks

Term Work: 25 Marks

Total: 50 Marks

Minimum Marks required: 20 Marks

PROCEDURE OF EVALUATION

Each practical/assignment shall be assessed continuously on the scale of 25 marks. The

distribution of marks as follows.

Rubrics

» Punctuality reflects the work

ethics. Students should reflect that
work ethics by completing the lab
assignments and reports in a
timely manner without being
reminded or warned.

Students are expected to write the
technical document (lab report) in
their own words. The presentation
of the contents in the lab report
should be complete,
unambiguous, clear, and
understandable. The report should
document
Approach/algorithm/design  and
code with proper explanation.

Sr. Evaluation Criteria Marks.for.each
No Criteria

1 Timely Submission 07

2 Presentation 06

3 Understanding 12

Correctness and Robustness of the
code is expected. The Learners
should have an in-depth
knowledge of the practical
assignment  performed.  The
learner should be able to explain
methodology used for designing
and developing the
program/solution. He/she should
clearly understand the purpose of
the assignment and its outcome.
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LABORATORY USAGE

Students use Mobile Development Lab to perform Mobile Computing practical. This Lab is
equipped with following hardware configuration: Intel Core i5 Processor CPU, Installed
Memory: 4GB, HDD: 500GB and Software Configuration: OS-Windows 8.1, Tools: Android
Studio, Turbo C,TASM, CISCO Packet Tracer, JDK, Rational Rose, Netbeans for executing the
lab experiments, document the results and to prepare the technical documents for making the lab
reports.

OBJECTIVE

The objective of this lab is to make students aware and practice implementation of various
mobile applications and projects through Android Studio.

PRACTICAL PRE-REQUISITE

» Java Programming Language
> Visual Studio
» Network and Internet

SOFTWARE REQUIREMENTS

> Android Studio

COURSE OUTCOMES

1. Explain the basic of mobile telecommunication system

2. Choose the required functionality at each layer

3. Application identity solution for each functionality at each layer
4. Use similar tool and design Ad- hoc networks

5. Develop mobile application
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HOW OUTCOMES ARE ASSESSED?

Outcome Assignment Number Level Proficiency
evaluated by
1. Explain the basic of Developed
mobile applications  and
telecommunication 1,2,3,459,10,11 3,3,3,3,3,2,3,2 executed
system programming
codes
2. Choose the required Developed
functionality at each applications and
layer 1,2,3,4,5,6,7 3,3,2,3,3,2,2 executed
programming
codes
3. Application identity Developed
solution for each applications and
functionality at each 3,45,6,7,8,9 3,3,3,2,3,2,3 executed
layer programming
codes
4. Use similar tool and Developed
design Ad-hoc applications and
networks 1,2,4,6,7 3,3,3,3,3 executed
programming
codes
5. Develop mobile Developed
application applications and
1,2,3,45,6,7,8,9,10,11 3,3,3,3,3,3,3,3,3,3,3 executed

programming
codes
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DESIGN EXPERIENCE GAINED

Students will gain the knowledge about Mobile Application development. Before starting with
Mobile Development part, student should follow the learned principles required to develop
application and execute the code.

LEARNING EXPERIENCE GAINED

Students will learn to develop an android application. Application can be considered as Project
also. So at the end of semester, students can develop their own project also based on Android
operating system.

LIST OF PRACTICAL ASSIGNMENTS:

1. To develop a Simple Android Application that uses GUI components, Font and Colors.

2. To develop a Simple Android Application that uses Layout Managers and Event Listeners.

3. To develop a Simple Android Application for Native Calculator.

4. Develop android application for spinning bottle game.

5. Android Studio Code to Develop Rolling Dice Game.

6. Develop android application for Login Page.

7. Develop android application for web application.

8. To develop a Simple Android Application that draws basic Graphical Primitives on the screen.

9. To develop a Simple Android Application that makes use of Database.

10. To develop a Android Application that creates Alarm Clock.

11. To develop a Android Application that creates an alert upon receiving a message.
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EXPERIMENT 01
Aim:
To develop a Simple Android Application that uses GUI components, Font and Colors.
Procedure:
Creating a New project:

= Open Android Stdio and then click on File -> New -> New project.

® ex.no.l - [C:\Users\devang\AndroidStudioProjects\ex.no.1] - Android Studio 1.4 @M
ZICW Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
New L Sew o e ¥m SREW ?2Q
1 Open... Import Project...
Reopen Project »  Project from Version Control »
Close Project New Module... m
9 Settings... Ctrl+Alt+S Import Module... %
[ Project Structure... Ctrl+Alt+Shift+S Import Sample... ;
Other Settings » © Java Class i
Import Settings... 3 Module 2
Export Settings... & Android resource file # L@
I Save Al Cirles ) Android resource directory  5ng exnot (14404) [DEAD)] - 2
(%] Synchronize Ctrl+Alt+Y El File i &
Invalidate Caches / Restart... [£1 Package ) Regex | Show only selected .
&5 Print... [5] C++ Class ;
A toF vontes ) B C/C++ SourceFile g
File Encoding [# C/C++ Header File ;
Line Separators » 15 Image Asset §
Make File Read-only lﬁ' Vector Asset
oD0 ™3 Eventlog  [Z] Gradle Console
Eqwessave Made m Sngleson n/a | n/a | Context: <nc context> B =

=  Then type the Application name as “ex.no.1"” and click Next.
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LTy — - ]

A New Project

Appcebonnene e rol

Company Domass  devarg evamgde com

Package nene ITTLasETIzI Serang sarzt Ea

Promctloeiere | Chbren dwoerg AncreesStache Proecty ecacd ]

The sapbemen rama for mest agpe begres with av uppot e et

Mot Canel ‘

=  Then select the Minimum SDK as shown below and click Next.

® Cruete New Projecs 0 - - ﬁ

M Target Android Devices

Select the form factors your app will run on

Diffesernt platfomms My ceqane sepacate SO

B e and Tabsiet
Miveraem S0¢ (89115 Andvond £33 GoaCreamSandancti  ~ |
Lowser APt lwsols target moee Sevc, Big Sevw feaw festiom svmlable. By tangeang A2115
and lates, yout app wil san an apgeosrately SLOK of (he dedioes that ae active on the
Gzogle Py Stzre
Help e chocse
1) Wear
Mpstramm S N1 2L Aradad A0 (Lol
Ll

B R ‘

= Then select the Empty Activity and click Next.
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™ Create o Pt -~ i

H Add an activity to Mobile

At No ATy

Bt Artty [ voson SRR Geogl st 4 Scty

-

| CGoogle Mazs Actrvy Logn Actaty Murter/ Detat Flaw Nengeton Dowewr Actaaty Scrcbng Acety

= Finally click Finish.

W Crente Now Progect - ﬁ

H Customize the Activity

Constes 2 vew oty actrorty

Activity Norves | Muirdmaty
Gerarme Layout Fie
Lopout Naress | ity mimn

Ermpty Actioty

= [t will take some time to build and load the project.

= After completion it will look as given below.
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Designing layout for the Android Application:

= Click on app -> res -> layout -> activity_main.xml.
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=  Now click on Text as shown below.
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= Then delete the code which is there and type the code as given below.

Code for Activity_main.xml:

<?xml version="1.0" encoding="utf-8"?>

<LinearLayout xmlIns:android="http://schemas.android.com/apk/res/android"
android:orientation="vertical"
android:layout_width="match_parent"

android:layout_height="match_parent">

<TextView
android:id="@+id/textView"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_margin="30dp"
android:gravity="center"
android:text="Hello World!"
android:textSize="25sp"

android:textStyle="bold" />
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http://schemas.android.com/apk/res/android

<Button
android:id="@-+id/button1"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_margin="20dp"
android:gravity="center"
android:text="Change font size"
android:textSize="25sp" />

<Button
android:id="@-+id/button2"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_margin="20dp"
android:gravity="center"
android:text="Change color"
android:textSize="25sp" />

</LinearLayout>

= Now click on Design and your application will look as given below.
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= So now the designing part is completed.

Java Coding for the Android Application:

= Click on app -> java -> com.example.exnol -> MainActivity.

® ool XM - i - e - paten =4 — v - Arawd o L4 s
B D B fegese Code dneyin Beecsr fobd Myn Took W5 fmdes bl
) “ XDo b Kb P e L ¥H TLES 7
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= Then delete the code which is there and type the code as given below.

Code for MainActivity.java:
package com.example.exnol;

import android.graphics.Color;

import android.support.v7.app.AppCompatActivity;
import android.os.Bundle;

import android.view.View;

import android.widget.Button;

import android.widget. TextView;

public class MainActivity extends AppCompatActivity
{
int ch=1;
float font=30;
@Override
protected void onCreate(Bundle savedlInstanceState)
{
super.onCreate(savedInstanceState);
setContentView(R.layout.activity main);
final TextView t= (TextView) findViewByld(R.id.textView);
Button b1= (Button) findViewByld(R.id.buttonl);
b1.setOnClickListener(new View.OnClickListener() {
@Override
public void onClick(View v) {
t.setTextSize(font);
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font=font + 5;
if (font ==50)
font = 30;
}
bl
Button b2= (Button) findViewByld(R.id.button2);
b2.setOnClickListener(new View.OnClickListener() {
@Override
public void onClick(View v) {
switch (ch) {
case 1:
t.setTextColor(Color.RED);
break;
case 2:
t.setTextColor(Color.GREEN);
break;
case 3:
t.setTextColor(Color.BLUE);
break;
case 4.
t.setTextColor(Color.CYAN);
break;
case 5:
t.setTextColor(Color.YELLOW);
break;
case 6:
t.setTextColor(Color MAGENTA);
break;
}
ch++;
if ch==7)
ch=1;

= So now the Coding part is also completed.

= Now run the application to see the output.

= OQutput:
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el okt Tt Wock Hello World!

CHANGEEONVOIZE)  (CHANGRFONTSIZE|  [oiiGEFONT Sz

SHONPECOLOR CHANGE COLOR CHANGE COLOR

Hello World! Hello World!

CHANGE FONT SIZE CHANGE FONT SIZE

CHANGE COLOR CHANGE COLOR

=  Result:

= Thusa Simple Android Application that uses GUI components, Font and Colors is developed and

executed successfully.
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EXPERIMENT NO 02
Aim:
To develop a Simple Android Application that uses Layout Managers and Event Listeners.
Procedure:
Creating a New project:
= Open Android Stdio and then click on File -> New -> New project.

® ex.nol - [C:\Users\devang\AndroidStudioProjects\ex.no.1] - Android Studio 1.4 ==
Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
New New Project... ¥ ¥ Eﬁ- % @ @ @‘ o9 Q
1 Open... Import Project...
Reopen Project » Project from Version Control » ...
Close Project New Module... m
<
95 Settings... Ctrl+Alt+S Import Module... )
[ Project Structure... Ctrl+Alt+Shift+S Import Sample... L
Other Settings » € Java Class ﬁ
Import Settings... 3 Module ! , : : 2
Export Settings... & Android resource file L
I save All Ctrles ) Android resource directory  5ng exnot (14404 [DEAD)] n 3
(%] Synchronize Ctrl+Alt+Y B File : . w
Invalidate Caches / Restart... [1 Package egex | Show only selected i &
B Print.. [S| C++ Class »
Add to Favorites » E# C/C++ Source File s
File Encoding [# C/C++ Header File ;
i o
Line Separators » 1 Image Asset g
Make File Read-only i Vector Asset
A s oD0 ™3 Eventlog  [E] Gradle Console
Eawespave Maoce Singleton n/a | n/a | Context: <nc context> -] ;
=  Then type the Application name as “ex.no.2" and click Next.
® Crute Mo Projest 0 A P — —— [~

( New Project

Configure your new project

[erez |

Corgeny Dormmn:  deveng exsrrple com
Package nwne T By e 1

Pagext bocaerne Chlsery deversg AndrodSiud cPropects o mo 2

The appheeson rarme for mont appe beg s wfh an spperctse et

N | oxe |

=  Then select the Minimum SDK as shown below and click Next.
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https://codingconnect.net/wp-content/uploads/2016/02/new-project.png
https://codingconnect.net/wp-content/uploads/2016/02/application-name-2-e1456664675131.png
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Select the form factors your app will run on
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Lowser APt lwsels target mose Sences, Big Savw feaw festines svmlable. By tgemng 49115
0 Lt yout app wil sun o0 apgrisimately SLOK of the devioes that are active on the
Ozoghe Py Stzre.
Help e chocse
1) Wear
Mpsrram SIM 2L Aradad A0 (Lolgay
Ll
Mpsrrasn SDE A 21 Aretract A0 (Lslpep n
[ Arkod e

e |

= Then select the Empty Activity and click Next.
1 Crvs o Pt == il

H Add an activity to Mobile

o .

SRUREEE . [resees o A A iy
| CGooghe Maze Actrmy Logn Actaty Muster Detas Flow Neageton Deaweer Actoaty Sercbng Aoty

= Finally click Finish.
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https://codingconnect.net/wp-content/uploads/2016/02/minimum-sdk-e1456069978476.png
https://codingconnect.net/wp-content/uploads/2016/02/empty-activity-e1456120797105.png

A Customize the Activity

Constes 2 vew errpsty sty
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LoyowtHame | sctry man

Empty Actinty

= It will take some time to build and load the project.
= After completion it will look as given below.

# o) Kt AnOor STy 20 1 - A Ses L4 e . T TE kRN
Do DR e fegene Cade dneyps Beteon feid Mn Tooh W5 e e

SHD #4 LD AR ¢ Hémrden l ¥ ILES 7 aqn
Sl - i

‘ D4 ~
N Ganite e

L]

I .
!

v

i

i

H

-

.

e Mg e i akat 1580 W dwing K waee Consite
D G o e 1 s b, ) TR Y )

Creating Second Activity for the Android Application:
= Click on File -> New -> Activity -> Empty Activity.
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= Type the Activity Name as SecondActivity and click Finish button.

9 Voo Aot Acty - st sl

A' Customize the Activity

Crestes » new evpty ity

. Actity N [ Secerdictnny
Gernuate Loy T
Lapsut Name | sinty_secons
(7] Lawncher Actwiey

Package nume | com earrple devmgonel -
Fomgay Activey

| The rarve of the actnty Chass to Creste

= Thus Second Activity For the application is created.
Designing layout for the Android Application:
Designing Layout for Main Activity:

= Click on app -> res -> layout -> activity_main.xml.
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https://codingconnect.net/wp-content/uploads/2016/02/New-activity-e1456766876210.png
https://codingconnect.net/wp-content/uploads/2016/02/SecondActivity-e1456766896789.png
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= Now click on Text as shown below.
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Then delete the code which is there and type the code as given below.
Code for Activity_main.xml:

<?xml version="1.0" encoding="utf-8"?>

<RelativeLayout xmlIns:android="http://schemas.android.com/apk/res/android"
xmins:tools="http://schemas.android.com/tools"
android:layout_width="match_parent"
android:layout_height="match_parent"
tools:context=".MainActivity">

<LinearLayout

android:layout_width="match_parent"

android:layout_height="100dp">

<TextView
android:id="@-+id/textView"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_margin="30dp"
android:text="Details Form"
android:textSize="25sp"
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android:gravity="center"/>
</LinearLayout>

<GridLayout
android:id="@-+id/gridLayout"
android:layout_width="match_parent"
android:layout_height="match_parent"
android:layout_marginTop="100dp"
android:layout_marginBottom="200dp"
android:columnCount="2"
android:rowCount="3">
<TextView
android:id="@+id/textViewl1"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_margin="10dp"
android:layout_row="0"
android:layout_column="0"
android:text="Name"
android:textSize="20sp"
android:gravity="center"/>

<EditText
android:id="@+id/editText"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_margin="10dp"
android:layout_row="0"
android:layout_column="1"
android:ems="10"/>

<TextView
android:id="@-+id/textView2"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_margin="10dp"
android:layout_row="1"
android:layout_column="0"
android:text="Reg.No"
android:textSize="20sp"
android:gravity="center"/>

<EditText
android:id="@+id/editText2"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_margin="10dp"
android:layout_row="1"
android:layout_column="1"
android:inputType="number"
android:ems="10"/>

<TextView

android:id="@+id/textView3"
android:layout_width="wrap_content"
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android:layout_height="wrap_content"
android:layout_margin="10dp"
android:layout_row="2"
android:layout_column="0"
android:text="Dept"
android:textSize="20sp"
android:gravity="center"/>

<Spinner
android:id="@-+id/spinner"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_margin="10dp"
android:layout_row="2"
android:layout_column="1"
android:spinnerMode="dropdown"/>

</GridLayout>

<Button
android:id="@-+id/button"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_alignParentBottom="true"
android:layout_centerinParent="true"
android:layout_marginBottom="150dp"
android:text="Submit"/>

</RelativeLayout>

= Now click on Design and your activity will look as given below.
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= So now the designing part of Main Activity is completed.
Designing Layout for Second Activity:
= Click on app -> res -> layout -> activity second.xml.
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= Now click on Text as shown below.
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= Then delete the code which is there and type the code as given below.
Code for Activity_second.xml:

<?xml version="1.0" encoding="utf-8"?>

<LinearLayout xmlIns:android="http://schemas.android.com/apk/res/android"
xmins:tools="http://schemas.android.com/tools"
android:layout_width="match_parent"
android:layout_height="match_parent"
tools:context="com.example.devang.exno2.SecondActivity"
android:orientation="vertical"
android:gravity="center">

<TextView
android:id="@+id/textViewl1"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_margin="20dp"
android:text="New Text"
android:textSize="30sp"/>

<TextView
android:id="@+id/textView2"
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android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_margin="20dp"
android:text="New Text"
android:textSize="30sp"/>

<TextView
android:id="@+id/textView3"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_margin="20dp"
android:text="New Text"
android:textSize="30sp"/>

</LinearLayout>
=  Nowclickon De5|gn and your activity WI|| look as given below.
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= So now the designing part of Second Activity is also completed.
Java Coding for the Android Application:
Java Coidng for Main Activity:

= Clickon app - ->java -> com.example. exn02 -> MainActivity.
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= Then delete the code which is there and type the code as given below.
Code for MainActivity.java:
package com.example.exno2;
import android.content.Intent;

import android.support.v7.app.AppCompatActivity;
import android.os.Bundle;
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import android.view.View;

import android.widget.ArrayAdapter;
import android.widget.Button;
import android.widget.EditText;
import android.widget.Spinner;

public class MainActivity extends AppCompatActivity {

/IDefining the Views
EditText el,e2;
Button bt;

Spinners;

/[Data for populating in Spinner
String [] dept_array={"CSE","ECE","IT","Mech","Civil"};

String name,reg,dept;

@Override

protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedlInstanceState);
setContentView(R.layout.activity_main);

/IReferring the Views
el= (EditText) findViewByld(R.id.editText);
e2= (EditText) findViewByld(R.id.editText2);

bt= (Button) findViewByld(R.id.button);
s= (Spinner) findViewByld(R.id.spinner);

/[Creating Adapter for Spinner for adapting the data from array to Spinner
ArrayAdapter adapter= new ArrayAdapter(MainActivity.this,android.R.layout.simple_spinner_item,dept_array);
s.setAdapter(adapter);

/ICreating Listener for Button
bt.setOnClickListener(new View.OnClickListener() {
@Override
public void onClick(View v) {

/IGetting the Values from Views(Edittext & Spinner)
name=el.getText().toString();
reg=e2.getText().toString();
dept=s.getSelectedltem().toString();

/lntent For Navigating to Second Activity
Intent i = new Intent(MainActivity.this,SecondActivity.class);

/[For Passing the Values to Second Activity
i.putExtra("name_key", name);
i.putExtra("'reg_key",reg);
i.putExtra("dept_key", dept);

startActivity(i);
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}
b
}
}

= So now the Coding part of Main Activity is completed.
Java Coding for Second Activity:
= Click on app -> java -> com.example.exno2 -> SecondActivity.
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= Then delete the code which is there and type the code as given below.
Code for SecondActivity.java:

package com.example.exno2;

import android.content.Intent;

import android.support.v7.app.AppCompatActivity;
import android.os.Bundle;

import android.widget. TextView;

public class SecondActivity extends AppCompatActivity {
TextView t1,t2,t3;
String name,reg,dept;

@Override

protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity _second);

t1= (TextView) findViewByld(R.id.textViewl);
t2= (TextView) findViewByld(R.id.textView?2);
t3= (TextView) findViewByld(R.id.textView3);

//Getting the Intent
Intent i = getintent();

/IGetting the Values from First Activity using the Intent received
name=i.getStringExtra("name_key");
reg=i.getStringExtra("'reg_key");
dept=i.getStringExtra("dept_key");
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//Setting the Values to Intent
tl.setText(name);
t2.setText(reg);
t3.setText(dept);

¥
¥

=  So now the Coding part of Second Activity is also completed.
= Now run the application to see the output.
Output:

v A44093% 1148

v 4d4093% 1150 v 4d4093% 1150

Details Form Details Form
Name | Name devang
devang
Reg.No Reg.No 111512104049
Dt oee Bent.  oee 111512104049
SUBMIT SUBMIT CSE
< o) O < o) O < o) O

Result:
Thus a Simple Android Application that uses Layout Managers and Event Listeners is developed and
executed successfully.
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EXPERIMENT 03
Aim:
To develop a Simple Android Application for Native Calculator.
Procedure:
Creating a New project:

»  Open Android Stdio and then click on File -> New -> New project.

# ex.no.l - [C:\Users\devang\AndroidStudioProjects\ex.no.1] - Android Studio 1.4 LEIM
Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
New New Project. ww Bg % @ Q @‘ = & |2?2Q
1 Open... Import Project...
Reopen Project » Project from Version Control » ..
Close Project New Module... mn
S Settings... Ctrl+Alt+S Import Module... ?
5 Project Structure... Ctrl+Alt+Shift+S Import Sample... ;
Other Settings » £ Java Class ‘i
Import Settings... 3 Module . 2
Export Settings... & Android resource file - L @
I Save All Ctrl+s 1 Android resource directory ang.exnol (14404) [DEAD] ﬂ L2
D Synchronize Ctrl+Alt+Y 21 File 2
Invalidate Caches / Restart... 3 Package ) Regex | Show only selected ; &
B Print... S| C++ Class b
Add to Favorites > 4 C/C++ Source File 3
File Encoding [# C/C++ Header File ;;
Line Separators » ' Image Asset =
Make File Read-only 1" Vector Asset
. oDo 3 Eventlog [=] Gradle Console
EawesSave Mode E] Singleton n/a | n/a | Context: <nc context> - !.!
» Then type the Application name as “ex.no.3"" and click Next.
) Croate Pew Project 00 . - — - -

Configure your new project

Apphcation neme | ecrod ]

Gompany Domads.  devarg eamgbe com

Promct laaticne | CAlher i devang i drozitadic Projects e S

The mapbesion raree fie w1est azps begpes ath ow usposcme ltte
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= Then select the Minimum SDK as shown below and click Next.

 Crurte P Projece - ——

H Target Android Devices

Select the form factors your app will run on
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» Then select the Empty Activity and click Next.

" Craate o Prect -~ il

H Add an activity to Mobile

o ' =

Blark Aty Futicren Adnaty Google AdMzb Ads Actrry
| CGooghe Maze Actrmy Logn Actaty Mt Detas Flow Neangeton Do Actoaty Sercbng Aoty

» Finally click Finish.
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= [t will take some time to build and load the project.

= After completion it will look as given below.
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Designing layout for the Android Application:

= Click on app -> res -> layout -> activity_main.xml.
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= Then delete the code which is there and type the code as given below.

Code for Activity_main.xml:

<?xml version="1.0" encoding="utf-8"?>

<LinearLayout
xmlns:android="http://schemas.android.com/apk/res/android"
android:orientation="vertical"
android:layout_width="match_parent"
android:layout_height="match_parent"
android:layout_margin="20dp">

<LinearLayout
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android:id="@-+id/linearLayout1"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_margin="20dp">

<EditText
android:id="@-+id/editText1"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:inputType="numberDecimal"
android:textSize="20sp" />

<EditText
android:id="@-+id/editText2"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_weight="1"
android:inputType="numberDecimal"
android:textSize="20sp" />

</LinearLayout>

<LinearLayout
android:id="@-id/linearLayout2"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_margin="20dp">

<Button
android:id="@-+id/Add"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_weight="1"
android:text="+"
android:textSize="30sp"/>

<Button
android:id="@+id/Sub"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_weight="1"

android:text="-
android:textSize="30sp"/>
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<Button
android:id="@+id/Mul"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_weight="1"
android:text="*"
android:textSize="30sp"/>

<Button
android:id="@+id/Div"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_weight="1"
android:text="/"
android:textSize="30sp"/>

</LinearLayout>

<TextView
android:id="@-+id/textView"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:layout_marginTop="50dp"
android:text="Answer is"
android:textSize="30sp"
android:gravity="center"/>

</LinearLayout>
» Now click on Design and your application will look as given below.
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= So now the designing part is completed.
Java Coding for the Android Application:

= Click on app -> java -> com.example.exno3 -> MainActivity.
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= Then delete the code which is there and type the code as given below.

Code for MainActivity.java:
package com.example.devang.exno3;

import android.os.Bundle;

import android.support.v7.app.AppCompatActivity;
import android.text. TextUtils;

import android.view.View;

import android.view.View.OnClickListener;
import android.widget.Button;

import android.widget.EditText;

import android.widget. TextView;

public class MainActivity extends AppCompatActivity implements OnClickListener
{

//Defining the Views

EditText Num1;

EditText Num2;

Button Add;

Button Sub;

Button Mul,

Button Div;

TextView Result;
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@Override
public void onCreate(Bundle savedinstanceState)
{
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

/IReferring the Views

Numl = (EditText) findViewByld(R.id.editTextl);
Num2 = (EditText) findViewByld(R.id.editText2);
Add = (Button) findViewByld(R.id.Add);

Sub = (Button) findViewByld(R.id.Sub);

Mul = (Button) findViewByld(R.id.Mul);

Div = (Button) findViewByld(R.id.Div);

Result = (TextView) findViewByld(R.id.textView);

// set a listener

Add.setOnClickListener(this);
Sub.setOnClickListener(this);
Mul.setOnClickListener(this);
Div.setOnClickListener(this);

}

@Override
public void onClick (View v)

{

float numl = 0O;
float num2 = 0;
float result = 0O;
String oper ="";

/I check if the fields are empty
if (TextUtils.isEmpty(Num1.getText().toString()) || TextUtils.isEmpty(Num2.getText().toString()))
return;

/l read EditText and fill variables with numbers num1
= Float.parseFloat(Num1.getText().toString()); num2
= Float.parseFloat(Num2.getText().toString());

/I defines the button that has been clicked and performs the corresponding operation
[/l write operation into oper, we will use it later for output
switch (v.getld())

{
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case R.id.Add:
oper ="+";
result = numl1 + num2;
break;
case R.id.Sub:
oper ="-";
result = num1 - numz2;
break;
case R.id.Mul:
oper ="*";
result = numl * numz;
break;
case R.id.Div:
oper ="/";
result =numl / num2;
break;
default:
break;
}
/I form the output line
Result.setText(numl +

}
}

= So now the Coding part is also completed.
= Now run the application to see the output.

+oper+""+num2 +" ="+ result);

Output:

2 or 10 5 10 5 10 5 10 5
+ * I\ X + + =8 W + S + = B/ + * |/
Answer is S o N r 10.0+5.0=15.0 10.0-5.0=5.0 10.0* 5.0 = 50.0 10.0/5.0=20
) c A
e 8
0

Result:

Thus a Simple Android Application for Native Calculator is developed and executed successfully.
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EXPERIMENT 04

Aim: Develop android application for spinning bottle game
Procedure:

First step is to find two specific images: one for the floor which will be defined as background of the game and other
for the bottle which will be rotated during the game.

We have chosen to use these both images:

Floor image for the background

Bottle image

Now, we need to define the layout of our game “Spin The Bottle”. We have a Relative Layout with the floor image
as background and we add a bottle in the center of this layout :
Code:
<?xml version="1.0" encoding="utf-8"?>
<RelativeLayout xmins:android="http://schemas.android.com/apk/res/android"
xmins:tools="http://schemas.android.com/tools"
android:id="@-+id/root"
android:layout_width="match_parent"
android:layout_height="match_parent"
android:background="@drawable/background">

<ImageView
android:id="@-+id/bottle"
android:layout_width="200dp"
android:layout_height="200dp"
android:src="@drawable/beer_bottle"
android:layout_centerInParent="true" />
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</RelativeLayout>

The next step is to write the Java code of the Main Activity. First, we get references for the views. Then, we install a
click listener on the main layout of the Main Activity. Thus, the user will just have to touch the screen to spin the
bottle and to start the game.

The core of the game is in the spinTheBottle() method. We are going to define a RotateAnimation from start angle
to end angle centered on the center of the bottle. The end angle will be defined randomly to simulate really the game
“Spin The Bottle”. We should store the last end angle value to restart the bottle in the same position for the next turn
of the game.

The Code of the Main Activity will have the following form :
package com.ssaurel.spinthebottle;

import android.os.Bundle;

import android.support.v7.app.AppCompatActivity;
import android.view.Menu;

import android.view.Menultem;

import android.view.View;

import android.view.animation.Animation;

import android.view.animation.RotateAnimation;
import android.widget.ImageView;

import android.widget. Toast;

import java.util.Random;

public class MainActivity extends AppCompatActivity {

public static final Random RANDOM = new Random();
private View main;

private ImageView bottle;

private int lastAngle = -1;

@Override
protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedlInstanceState);
setContentView(R.layout.activity _main);
main = findViewByld(R.id.root);
bottle = (ImageView) findViewByld(R.id.bottle);
main.setOnClickListener(new View.OnClickListener() {
@Override
public void onClick(View view) {
spinTheBottle();
}
bk
Toast.makeText(this, R.string.touch_to_spin, Toast LENGTH_SHORT).show();
}

@Override

public boolean onCreateOptionsMenu(Menu menu) {
getMenulnflater().inflate(R.menu.main, menu);
return true;
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@Override
public boolean onOptionsltemSelected(Menultem item) {
switch(item.getltemlId()) {
case R.id.action_spin:
spinTheBottle();
break;
case R.id.action_zero :
resetTheBottle();
break;
}

return super.onOptionsltemSelected(item);

}

private void spinTheBottle() {
int angle = RANDOM.nextInt(3600 - 360) + 360;
float pivotX = bottle.getWidth() / 2;
float pivotY = bottle.getHeight() / 2;
final Animation animRotate = new RotateAnimation(lastAngle == -1 ? 0 : lastAngle, angle, pivotX, pivotY);
lastAngle = angle;
animRotate.setDuration(2500);
animRotate.setFill After(true);
bottle.startAnimation(animRotate);

}

private void resetTheBottle() {
float pivotX = bottle.getWidth() / 2;
float pivotY = bottle.getHeight() / 2;
final Animation animRotate = new RotateAnimation(lastAngle == -1 ? 0 : lastAngle, 0, pivotX, pivotY);
lastAngle = -1;
animRotate.setDuration(2000);
animRotate.setFill After(true);
bottle.startAnimation(animRotate);
}

}
Output:
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Result:

LT G UL WAUGEC . 1Y
import java.util.Random;
®  public class MainActivit

itAngle, angle, pivotX, pivotY);

After implementing this, students will understand the use of multimedia files and random function in android studio.
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EXPERIMENT 05

Aim: Android Studio Code to Develop Rolling Dice Game

The Dice Face Images and Sound

Procedure:

The code given in this article is for a common six sided dice. A dice is a cube, and each side of the cube (each face)
has one of the numbers from one to six. Here six PNG images are used to show the dice roll result. Plus there is a 3D
image shown for the dice roll. The same 3D image is used for the app icon.

The sound of a dice roll is stored in shake dice.mp3. It is by Mike Koenig and is from SoundBilble.com.

All the resources ready to add into a Android Studio project are available from this dice resources Zip file.

Android Studio Dice Roller Project

For this tutorial start a new Android Studio project. Here the Application name is Dice and an Empty Activity is used
with other settings left at default values. Add the dice resources (from above) to the project by copying them to
the res folder. Studio will update the Project explorer automatically (or use the Synchronize option).

[+ = | drawable-mdpi — [ >

Home Share Wieww e

— S b <« res » drawable-mdpi w0 Search dra... O

e main i =

jawa
) c
s res - ':

P

drawable

drawable-hdpi dice3d.png dicez3droll.png

drawable-1dpi
L L L

drawable-rmdpi

L
drawable-xhdpi
L @ ® L

drawable-xchdpi
layout five.png four.png
mipmap-hdpi

L
mipmap-ldpi '. '-
L

miprmap-mdpi

mipmap-xhdpi ocne.png si.png
mipmap-xxchdpi o o
mipmap-:ococchdpi .

e ® ®

walues
hd three.png two.png al

3 itermns 3=z [=]]
Optionally change the app icon entries in the AndroidManifest.xml file to dice3d and dice3d_rounded.png,
i.e. android:icon="@drawable/dice3d" and android:roundlcon="@mipmap/dice3d_rounded".

Android Dice Roller Project Layout
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The screen for the dice roller is very simple. Just an ImageView which when pressed the roll is performed. If using
the basic starting empty screen then open the activity main.xml layout file. Delete the Hello
World! default TextView (if present). From the widget Pallete, under Images, drag and drop an ImageView onto the
layout and select dice3droll on the Resources chooser dialog. (Add the constraints if using a ConstraintLayout.)

E EI @v DN&xus4v #8725 '@'AppTheme
® W i 8 E-F-I-O0x@= W H

[u] 100 200 300 400 =] a0 oo

The layout source should be similar to the following:
<?xml version="1.0" encoding="utf-8"?>
<android.support.constraint.ConstraintLayout xmlIns:android="http://schemas.android.com/apk/res/android"
xmlns:app="http://schemas.android.com/apk/res-auto"
xmins:tools="http://schemas.android.com/tools"
android:layout_width="match_parent"
android:layout_height="match_parent"
tools:context="com.example.dice.MainActivity">

<ImageView
android:id="@-+id/imageView"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_marginLeft="16dp"
android:layout_marginStart="16dp"
android:layout_marginTop="16dp"
android:contentDescription="Press for Dice Roll"
app:layout_constraintLeft_toLeftOf="parent"
app:layout_constraintTop_toTopOf="parent"
app:srcCompat="@drawable/dice3droll" />

</android.support.constraint.ConstraintLayout>
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Android Dice Roller Source Code

A Java Random class (to generate the dice numbers) is declared along with an Android SoundPool (to play the dice
roll sound). To load the right picture for each roll a switch statement is used. Some feedback is provided to the user
so that they can see that a new roll has occurred. An identical number can be rolled in succession. To provide the
feedback a 3D dice image will be displayed. However, because the roll happens so fast (unlike a real dice) the 3D
image would not be seen. Therefore a Timer is used to provide a delay. This allows the Ul to update. The Timer
sends a Handler message signal to a Callback to perform the roll (the same method as described in the post Why
Your TextView or Button Text Is Not Updating). Finally the roll value is used to update the UI.

Update: The creation of the SoundPool object has changed due to the deprecation of the constructor in Android API
21 and later. The code has been changed to allow for this, using a SoundPool.Builder. To support pre-Lollipop
Android versions a new class is added to the project called PreLollipopSoundPool. The code for this new class
follows this MainActivity class:

package com.example.dice;

import android.media.AudioAttributes;

import android.media.SoundPool;

import android.os.Build;

import android.os.Handler;

import android.os.Message;

import android.support.v7.app.AppCompatActivity;
import android.os.Bundle;

import android.view.View;

import android.widget.ImageView;

import java.util. Random;
import java.util. Timer;
import java.util. TimerTask;

publicclassMainActivityextendsAppCompatActivity {
ImageView dice_picture; //reference to dice picture
Random rng=new Random(); //generate random numbers
SoundPool dice_sound;  //For dice sound playing
int sound_id,; //Used to control sound stream return by SoundPool
Handler handler; //Post message to start roll
Timer timer=new Timer(); //Used to implement feedback to user
boolean rolling=false;  //Is die rolling?

@Override
protectedvoidonCreate(Bundle savedinstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity main);
/[Our function to initialise sound playing
InitSound();
//Get a reference to image widget
dice_picture = (ImageView) findViewByld(R.id.imageView);
dice_picture.setOnClickListener(new HandleClick());
/Nlink handler to callback
handler=new Handler(callback);

}
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//User pressed dice, lets start
privateclassHandleClickimplementsView.OnClickListener {
publicvoidonClick(View arg0) {
if (frolling) {

rolling = true;
/IShow rolling image
dice_picture.setimageResource(R.drawable.dice3droll);
//Start rolling sound
dice_sound.play(sound_id, 1.0f, 1.0f, 0, 0, 1.0f);
/[Pause to allow image to update
timer.schedule(new Roll(), 400);
}
}
}

/INew code to initialise sound playback
voidInitSound() {
if (Build.VERSION.SDK_INT >= Build.VERSION_CODES.LOLLIPOP) {
//Use the newer SoundPool.Builder
//Set the audio attributes, SONIFICATION is for interaction events
[luses builder pattern
AudioAttributes aa = new AudioAttributes.Builder()
.setUsage(AudioAttributes. USAGE_ASSISTANCE_SONIFICATION)
.setContentType(AudioAttributes. CONTENT_TYPE_SONIFICATION)
build();

//default max streams is 1
/lalso uses builder pattern
dice_sound= new SoundPool.Builder().setAudioAttributes(aa).build();

Yelse {

/IRunning on device earlier than Lollipop

//Use the older SoundPool constructor

dice_sound=PreLollipopSoundPool.NewSoundPool();
}
/[Load the dice sound
sound_id=dice_sound.load(this,R.raw.shake_dice,1);

}

//When pause completed message sent to callback
classRollextendsTimerTask {
publicvoidrun() {
handler.sendEmptyMessage(0);
}
}

/IReceives message from timer to start dice roll
Handler.Callback callback = new Handler.Callback() {
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publicbooleanhandleMessage(Message msg) {
//Get roll result
//Remember nextint returns 0 to 5 for argument of 6

I//hence +1
Switch (rng.nextint(6)+1) {
case 1:
dice_picture.setimageResource(R.drawable.one);
break;
case 2:
dice_picture.setimageResource(R.drawable.two);
break;
case 3:
dice_picture.setimageResource(R.drawable.three);
break;
case 4:
dice_picture.setimageResource(R.drawable.four);
break;
case 5:
dice_picture.setimageResource(R.drawable.five);
break;
case 6:
dice_picture.setimageResource(R.drawable.six);
break;
default:
}
rolling=false; //user can press again
returntrue;
}
3
//Clean up

protectedvoidonPause() {
super.onPause();
dice_sound.pause(sound_id);
}
protectedvoidonDestroy() {
super.onDestroy();
timer.cancel();

¥
¥

To support APIs pre Lollipop add a new class called PreLollipopSoundPool in the same folder as
the MainActivity class. Creating it as a separate class supports Java lazy loading, ensuring the app works when the

deprecated method is removed from Android.
package com.example.dice;

import android.media.AudioManager;
import android.media.SoundPool;

/**
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* Created a pre Lollipop SoundPool

*/

finalclassPreLollipopSoundPool {
@SuppressWarnings(“deprecation™)

publicstatic SoundPool NewSoundPool() {

returnnew SoundPool(1, AudioManager.STREAM_MUSIC,0);
}

}

The Android dice roller source code is now ready to run, either in an AVD or an actual Android device.
Output:

Result: The Spinning Bottle game is developed through Android Studio and all required knowledge and skills have
understood
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EXPERIMENT 06
Aim: Develop android application for Login Page

Procedure:

Stepl:

Creating a simple android login screen under Linear Layout.
Project Structure:;

> manifests
v java
v com.onlinetutorialspoint.official simplelogin
€ MainActivity
> com.onlinetutorialspoint.official simplelegin (androidTest)
> com.onlinetutorialspeint.official.simplelogin (test)
v res
> drawable
v layout

s activity_mainaxml
> mipmap
> values
~ (% Gradle Scripts

& build.gradle (Project: Simplelogin)

& build.gradle (Module: app)

1| gradle-wrapper.properties (Grad|e Version)
= proguard-rules.pro (ProGuard Rules for app)
1| gradle.properties (Project Properties)

& settings.gradle (Project Settings)

1| local.properties (SOK Location)

Gradle Dependencies:
apply plugin: ‘com.android.application’

android {

compileSdkVersion 27

defaultConfig {

applicationld "com.onlinetutorialspoint.official.simplelogin”

minSdkVersion 23

targetSdkVersion 27

versionCode 1

versionName "1.0"

testInstrumentationRunner “android.support.test.runner.AndroidJUnitRunner"
}

buildTypes {

release {

minifyEnabled false

proguardFiles getDefaultProguardFile('proguard-android.txt’), 'proguard-rules.pro'
}

}

}

dependencies {

implementation fileTree(dir: 'libs', include: [*.jar"])

implementation ‘com.android.support:appcompat-v7:27.0.1'
implementation ‘com.android.support.constraint:constraint-layout:1.0.2'
testimplementation 'junit:junit:4.12'
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androidTestimplementation ‘com.android.support.test:runner:1.0.1'
androidTestImplementation ‘com.android.support.test.espresso:espresso-core:3.0.1'
}

activity_main.xml

Step2:

Creating a basic login form layout using LinearLayout having one text box, password and Login button.
<?xml version="1.0" encoding="utf-8"?>
<RelativeLayout xmins:android="http://schemas.android.com/apk/res/android"
xmins:app="http://schemas.android.com/apk/res-auto"
xmins:tools="http://schemas.android.com/tools"
android:layout_width="match_parent"
android:layout_height="match_parent"
tools:context="com.onlinetutorialspoint.official.simplelogin.MainActivity">

<LinearLayout
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:orientation="vertical"
android:layout_marginLeft="16dp"
android:layout_marginRight="16dp"

android:layout_centerInParent="true">

<EditText
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:hint="UserName"
android:id="@+id/username"/>
<EditText
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:hint="password"
android:id="@-+id/password"
android:inputType="textPassword"

/>

<Button
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:text="Login"
android:background="#3f76ff"
android:textColor="#fff"
android:id="@-+id/login"/>

</LinearLayout>

</RelativeLayout>
MainActivity.java
Step3:
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Creating MainActivity.java, responsible to read the input from the about layout and validate the user inputs.
package com.onlinetutorialspoint.official.simplelogin;

import android.support.v7.app.AppCompatActivity;
import android.os.Bundle;

import android.view.View;

import android.widget.Button;

import android.widget.EditText;

import android.widget. Toast;

import java.util.Objects;

public class MainActivity extends AppCompatActivity {
EditText username,password:;

Button login;

@Override

protected void onCreate(Bundle savedinstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
username=findViewByld(R.id.username);
password=findViewById(R.id.password);
login=findViewById(R.id.login);
login.setOnClickListener(new View.OnClickListener() {
@Override

public void onClick(View view) {
if(Objects.equals(username.getText().toString(),
"admin")&&Objects.equals(password.getText().toString(),"admin™))
{

Toast.makeText(MainActivity.this,"You have Authenticated
Successfully”, Toast LENGTH_LONG).show();

Jelse

{
Toast.makeText(MainActivity.this,"Authentication Failed", Toast. LENGTH_LONG).show();

Run Application:
Run Android Virtual Device (AVD):

Output:
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Results:
After developing this application, students will be able to connect multiple classes in android studio
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EXPERIMENT 07

Aim: Develop android application for web application
Procedure:
1. Introduction
An Android web app is an application that uses WebView to render part of the app’s GUIL. As name
suggests, WebView is a View that displays Web pages. Let’s say you are in Facebook and it shares some link.
Instead of opening the link in browser, it uses the WebView component to open the link in the app itself. It is an
extension of Android’s View class that allows to display web pages as a part of Activity layout. WebView by
default displays only webpage i.e. it does not include features of fully developed web browser like navigation and
address bar. There are additional methods used to manually include all the features of a Web browser (managing
cookies, history, navigating forward and backward, bookmarks and so on). We will discuss these methods in the
next section.
WebView uses Webkit rendering engine to display web pages and includes all of the above methods. To know more
about the Webkit check here.
2. Methods & Description
To have a more control over WebView, we can use the following methods defined in the WebView class.

e canGoBack() — This method specifies if the WebView has a back history item.

e canGoForward() — This method specifies if the WebView has a forward history item.

e clearHistory() — This method clears up the WebView forward and backward history.

o destroy() — This method destroys the internal state of WebView. It is required not to call any other method

of WebView after calling destroy(), as this might can result in app crash.
o findAllAsync() — This method finds of instances of the string and highlight them. Works the same way as
WebBrowser when we press CTRL+F to look for any String.

e getsProgress() — This method gets the progress of the current page. It returns the value between 1 and 100.

e getsTitle() — This method gets the title of the current page.

e getUrl() — This method gets the URL of the current page.
Signature of above methods

Webview webview = (Webview) findviewbyld(R.id.webview);

if(webView.canGoBack()){
webView.goBack();

if(webView.canGoForward()){
webView.goForward();

webView.clearHistory();
webView.destroy();

int find AllAsync(String find)

int progress = webview.getProgress()
String title = webview.getTitle()

String url = webview.getUrl()}
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Apart from these methods, there are several other customization points where you can add your own behavior. These
are:
e Creating and setting a WebChromeClient subclass. This class is called when something that might impact a
browser Ul happens, for instance, progress updates and JavaScript alerts are sent here.
e Creating and setting a WebViewClient subclass. It will be called when things happen that impact the
rendering of the content(For example: errors or form submissions). You can also intercept URL loading
here (via shouldOverrideUrILoading()).
e Modifying the WebSettings, such as enabling JavaScript with setJavaScriptEnabled().
e Injecting Java objects into the WebView using the addJavascriptinterface(Object, String) method. This
method allows you to inject Java objects into a page’s JavaScript context, so that they can be accessed by
JavaScript in the page.
Let’s start creating a Android Web Application example that illustrates the wuse of WebView.
IDE used — Android Studio 3.0 (You can use Eclipse as well, but Android studio works well with Gradle. Fore more
info about Gradle read here — https://developer.android.com/studio/build/index.html
Download Android Studio 3.0: https://developer.android.com/studio/index.html
3. Simple Android WebView Example
Firstly, we will create a basic app which will show you how to add WebView excluding the additional methods
which will be discussed in the latter section.

Layout File
To add a WebView to the application, simple include the element in activity layout.
activity web.xml

<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"

android:layout_width="fill_parent"

android:layout_height="fill_parent”

xmins:app="http://schemas.android.com/apk/res-auto”

android:orientation="vertical">

<WebView
android:id="@+id/webView"
android:layout_width="match_parent"
android:layout_height="match_parent" />
</LinearLayout>
Activity File
Now in the Activity use the loadUrl() to load a particular url.
WebActivity.java
public class WebActivity extends AppCompatActivity {
WebView webView;

@Override

protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity _web);
webView = (WebView) findViewByld(R.id.webView);
webView.loadUrl("www.google.com™);

}

}
Manifest File

Since we we will be connecting to the web, add Internet permissions in the Manifest File.
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AndroidManifest.xml

1  <uses-permission android:name="android.permission.INTERNET" />
Run the application

In the screenshot, the url gets loaded in the app browser.

7] FUR.471%0 1:53 PM

= ALL  IMAGES HH Sign in

Google

Adver

sing Business About

4. Display Custom HTML
Sometimes, there’s need to open web page from the app’s local storage instead from a url. In order to do so, keep all
the HTML, CSS and Fonts in Assets folder and load them from there.

Create HTML file
Add the Assets folder in the application.
You can create the assets folder by: Right Click on app -> New -> Folder -> Assets Folder.

G Project - QR B 1- G sty mainaen 3 activity wed_view xmi © Webhctivity jave
v AndroltWebApp -/ Data/Andeod Apps/Anue WebActivity | onCreatel)

> ™
o = & Angroid resource file
Y byl Link C++ Project with Gradle

> B Android resource directory
s Cut %) ™ Sample Data directory ty extends ApplompatActivity {
v [ Copy sxc | M Fie
Copy Path oRC #. Scratch File OEN
Copy a$ Plain Text B Directory .t:‘:‘;ﬁfftf’:;;:?i?‘aq(cs“"“
Copy Relative Path NO#C 5 [R. Layout.activity_web) |
i Paste xv 15 C++ Class Tiew) 100V iewByIdiR. 1. webView)
@« C/C++ Source Fie
Find Usages \F7 | & C/C++HeaderFie LW Tile; // fandroid_ssset/web htn
F in Path.... CWF
e ‘_)“ % # Image Asset
Replace in Path.... O8R 2
W Vector Asset
Analyze »
{ & W AL B
Refact
L ol W Activity >
» Bay AddtoFavorites » W Android Aute >
2 Show Image Thumbnais 087 Folder [l [ AIDL Folder
] # Fragment > Assets Folder
@ Retormat Code X¥%L | & Google > | [L JNI Foider
. timi X A oy
1 Optimize Imgorts X0 # Other » | O Java Folder
R 1D Run Al Tests' ~oRp | ' Service » [ Java Resources Folder
% | # Debug 'All Tosts' ~gp | ‘% UiComponent » [k RenderScript Folder
4 e = 3 ar 0 ns Foider
@) ik Run 'All Tests' with Coverage # Wear > | Dk Res Foder

Create a HTML file in assets Folder
Now locate the assets folder here. src -> main -> assets. Create a new HTML file : Right Click on assets -> New ->
File.
web.html

<Idoctype htmlI>

<htmlI>

<head>

<title>Android WebView Example</title>
</head>
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<body>
<h1 style="font-family:roboto;color:green;margin-left:30px;">This is custom HTML loaded from app storage</h1>
<p>Loading custom HTML is useful where you want to show static HTML, like privacy policy or user agreement in yoyr app
</body>
</html>
Activity File
Now use the loadUrl() method to load a custom url.
WebActivity.java
1 webView.loadUrl("file://fandroid_asset/web.html");
Run the Application
On running the application, custom HTML will be showed up.

O T 482%02:42PM

This is custom HTML
loaded from app
storage

Loading custom HTML is useful where you want
to show static HTML, like privacy policy or user
agreement in your app.

5. Using JavaScript in WebView

If the web page you plan to load in your WebView uses JavaScript, you must enable JavaScript for your WebView.
Once JavaScript is enabled, you can also create interfaces between your application code and your JavaScript
code. JavaScript is disabled in a WebView by default. It can be enabled through the WebSettings attached to
the WebView. You can retrieve WebSettings with getSettings(), then enable JavaScript with setJavaScriptEnabled().
It’s also possible to bind the JavaScript code in your web page to android WebView code like calling a method in
your app to display alert dialog rather than using alert() in JavaScript.

Enabling JavaScript

WebView myWebView = (WebView) findViewByld(R.id.webview);

WebSettings webSettings = myWebView.getSettings();

webSettings.setJavaScriptEnabled(true);
WebSettings provides access to a variety of other settings that you might find useful. For example, if you’re
developing a web application that’s designed specifically for the WebView in your Android application, then you
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can define a custom user agent string with setUserAgentString(), then query the custom user agent in your web page
to verify that the client requesting your web page is actually your Android application.
6. Handling Page Navigation

When the user clicks a link from a web page in your WebView, the default behavior is for Android to launch an
application in a web browser. However, you can override this behavior for your application and so, links will open
within your WebView. You can then allow the user to navigate backward and forward through their web page
history that’s maintained by WebView.
To open the links clicked by user, simply provide a WebViewClient for your WebView, using setWebViewClient().
Signature of setWebViewClient()
myWebView.setWebViewClient(new WebViewClient());
If you want to add backward and forward arrows in the application just like Web application, it can be done
manually by adding the icons in the ActionBar and call goBack() and goForward() respectively. By doing so, you
would be able to handle the already browsed pages. We will use it in our code in next section.
7. Creating the Application with Page Navigation
In this example we will learn how to add back and forward arrows in Activity.
Layout File
This is the Main Activity. We are passing the url to the WebViewActivity.
activity main.xml
<?xml version="1.0" encoding="utf-8"?>
<android.support.constraint.ConstraintLayout xmlns:android="http://schemas.android.com/apk/res/android"
xmins:app="http://schemas.android.com/apk/res-auto"
xmins:tools="http://schemas.android.com/tools"
android:layout_width="match_parent"
android:layout_height="match_parent">
<Button
android:id="@-+id/url"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_marginBottom="20dp"
android:layout_marginStart="64dp"
android:layout_marginTop="181dp"
android:text="Go to https://www.w3schools.com/"
android:textAllCaps="false"
app:layout_constraintBottom_toTopOf="@-+id/custom_html_button"
app:layout_constraintStart_toStartOf="parent"
app:layout_constraintTop_toTopOf="parent" />

<Button
android:id="@+id/custom_html_button"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_marginBottom="214dp"
android:layout_marginStart="44dp"
android:text="Load Custom HTML"
android:textAllCaps="false"
app:layout_constraintBottom_toBottomOf="parent"
app:layout_constraintStart_toStartOf="@-+id/url"
app:layout_constraintTop_toBottomOf="@-+id/url" />
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</android.support.constraint.ConstraintLayout>
Here we have another layout to display the web pages.
activity web_view.xml

<?xml version="1.0" encoding="utf-8"?>
<LinearLayout xmlIns:android="http://schemas.android.com/apk/res/android"
android:layout_width="fill_parent"
android:layout_height="fill_parent"
xmlns:app="http://schemas.android.com/apk/res-auto"
android:orientation="vertical">
<android.support.design.widget. AppBarLayout
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:theme="@style/AppTheme">
<android.support.v7.widget. Toolbar
android:id="@-+id/toolbar"
android:layout_width="match_parent"
android:layout_height="7attr/actionBarSize"
android:background=""?attr/colorPrimary"
app:popupTheme="@style/AppTheme.PopupOverlay" />

</android.support.design.widget. AppBarLayout>

<WebView
android:id="@+id/webView"
android:layout_width="match_parent"
android:layout_height="wrap_content" />
</LinearLayout>
Activity File

This the main activity. On clicking the Upper button, WebViewActivity will be opened. On clicking the Load
Custom HTML button, WebActivity will be opened discussed in Section 4.
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MainActivity.java

public class MainActivity extends Activity {

private Button customButton;
private Button urlButton;

String url = "https://www.w3schools.com/";

public void onCreate(Bundle savedInstanceState) {

final Context context = this;

super.onCreate(savedlInstanceState);

setContentView(R.layout.activity main);

urlButton = (Button)findViewByld(R.id.url);

customButton = (Button) findViewByld(R.id.custom_html_button);

urlButton.setOnClickListener(new OnClickListener() {

@Override

public void onClick(View arg0) {
Intent intent = new Intent(MainActivity.this, WebViewActivity.class);
intent.putExtra("url”, url);

startActivity(intent);

;

customButton.setOnClickListener(new OnClickListener() {

@Override

public void onClick(View arg0) {
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Intent intent = new Intent(context, WebActivity.class);

startActivity(intent);

ok

}

Here is the WebViewActivity which will display the webpage and handling navigation.

WebViewActivity.java

public class WebViewActivity extends AppCompatActivity {

private String url;

private WebView webView;

@Override

protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedlInstanceState);
setContentView(R.layout.activity_web_view);
Toolbar toolbar = (Toolbar) findViewByld(R.id.toolbar);
setSupportActionBar(toolbar);
getSupportActionBar().setDisplayHomeAsUpEnabled(true);

getSupportActionBar().setTitle(");

url = getintent().getStringExtra("url");

webView = (WebView) findViewByld(R.id.webView);

webView.setWebViewClient(new WebViewClient() {
@Override
public void onPageStarted(WebView view, String url, Bitmap favicon) {
super.onPageStarted(view, url, favicon);

invalidateOptionsMenu();
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}
@Override

public boolean shouldOverrideUrlLoading(WebView view, String url) {
webView.loadUrl(url);
return true;

¥

@Override

public void onPageFinished(WebView view, String url) {
super.onPageFinished(view, url);
invalidateOptionsMenu();

}

@Override

public void onReceivedError(WebView view, WebResourceRequest request, WebResourceError error) {
super.onReceivedError(view, request, error);

invalidateOptionsMenu();

}
H

webView.clearCache(true);
webView.clearHistory();

webView.loadUrl(url);

@Override
public boolean onCreateOptionsMenu(Menu menu) {
getMenulnflater().inflate(R.menu.brower, menu);

return super.onCreateOptionsMenu(menu);

@Override

public boolean onPrepareOptionsMenu(Menu menu) {
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if (lwebView.canGoBack()) {
menu.getltem(1).setEnabled(false);

}else {

menu.getltem(1).setEnabled(true);

if ('webView.canGoForward()) {
menu.getltem(2).setEnabled(false);

Yelse {

menu.getltem(2).setEnabled(true);

}

return true;

@Override
public boolean onOptionsitemSelected(Menultem item) {
switch (item.getltemlid()){
case R.id.action_home :
webView.loadUrl("https://www.w3schools.com/");
break;
case R.id.action_back :
if(webView.canGoBack()){ webView.goBack(); }
break;
case R.id.action_forward :
if(webView.canGoForward()){ webView.goForward(); }
break;

}

return super.onOptionsltemSelected(item);
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For your reference, to add the icons: Right click on Drawable Folder -> New -> Vector Asset. From here you can
choose the icon to be added to the application.

Manifest File
This is the AndroidManifest File.

AndroidManifest.xml

<?xml version="1.0" encoding="utf-8"?><
manifest xmins:android="http://schemas.android.com/apk/res/android" package="com.example.archigupta.androidwebapp'
<application

android:allowBackup="true"

android:icon="@mipmap/ic_launcher"

android:label="@string/app_name"

android:roundlcon="@mipmap/ic_launcher_round"

android:supportsRtl="true"

android:theme="@style/AppTheme.NoActionBar">

<activity
android:name=".MainActivity"
android:label="@string/title_activity _web_view">
<intent-filter>

<action android:name="android.intent.action.MAIN" />

<category android:name="android.intent.category.LAUNCHER" />
</intent-filter>

<[activity>

<activity
android:name=".WebViewActivity"
android:label="@string/title_activity_web_view">

</activity>
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<activity
android:name=".WebActivity"
android:label="@string/title_activity_web_view">

<[activity>

</application>
</manifest>
Run the application See

the screenshots here.

w3schools.com

Go to https://www.w3schools.com/ H I M L

The language for building web
Load Custom HTML pages

LEARN HTML HTML REFERENCE

On clicking the Load Custom HTML button, the Image in Section 4.3 will be opened up.

Result:

We have seen how to use WebView in the application. A big advantage of using a WebView is that you can store
assets inside the app. This lets your app work offline and improves load times, since the WebView can retrieve
assets directly from the local file system. Also, it provides interesting methods for Web pages to interact with
the Android app using Javascript interface. Another scenario where it is helpful is when you want to provide
information in your application that you might need to update, such as an end-user agreement or a user guide.
Within your Android application, you can create an Activity that contains a WebView, then use that to display your
document that’s hosted online.
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EXPERIMENT 08

Aim:

To develop a Simple Android Application that draws basic Graphical Primitives on the screen.
Procedure:

Creating a New project:

= Open Android Studio and then click on File -> New -> New project.
-Q ex.no.l - [CA\Users\devang\AndroidStudioProjects\ex.no.1] - Android Studio 1.4 @Eﬂ

J3CW Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
% b @ ¢RE® ?2Q
[ Open... Import Project...

Reopen Project » Project from Version Control »

Close Project New Module... m
¥ Settings... Ctrl+Alt+S Import Module... ?
[ Project Structure... Ctrl+Alt+Shift+S Import Sample... ;

Other Settings » © JavaClass f{

Import Settings... 23 Module ’ 2

Export Settings... & Android resource file # L@
& Save All Ctrl+S [ Android resource directory ang.exnol (14404) [DEAD] n ng:
(%] Synchronize Ctrl+Alt+Y El File s

Invalidate Caches / Restart... [£1 Package ) Regex | Show only selected .
= Print... |8| C++ Class z

Add to Favorites > &+ C/C++ Source File 5

e [ C/C++ Header File g

Line Separators » ' Image Asset §

Make File Read-only &' Vector Asset

oD0 ™3 Eventlog [l Gradle Console
Power Save Mode 0} Singleton s I ot s Cor ot » 8
=  Then type the Application name as “ex.no.4" and click Next.
e .

{ New Project

Configure your new project

Appication nane | e rot 1
Convwany Do | devers exarrgde com

Package nane et phe b g ans il ke

Poagext bocuen Chlhery deveryg AsdodStud eProecs ex sod

The appbcrsen narme for pul appe begges weh an sppocare les

=  Then select the Minimum SDK as shown below and click Next.
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= Then select the Empty Activity and click Next.

M Crente Now Proect

H Add an activity to Mobile

At No ATy

| CGoogle Maze Actrvy

Logm Actawty

Bark Actaty

Futicoeen Actrety

-

Neageton Deweer Actoaty

Murtee Detag Flaw

Google AdMeb Ads Actrory

Sorcbng Acety

= Finally click Finish.
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= |t will take some time to build and load the project.
= After completion it will look as given below.
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i

¥

i

i

~

-

.
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!uuu—-h‘-a—‘m ot Lamded + - atred. e

Designing layout for the Android Application:
= Click on app -> res -> layout -> activity_main.xml.
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= Now click on Text as shown below.
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= Then delete the code which is there and type the code as given below.
Code for Activity_main.xml:

<?xml version="1.0" encoding="utf-8"?>

<RelativeLayout xmlIns:android="http://schemas.android.com/apk/res/android"
android:layout_width="match_parent"
android:layout_height="match_parent">

<ImageView
android:layout_width="match_parent"
android:layout_height="match_parent"
android:id="@+id/imageView" />
</RelativeLayout>

= Now click on Design and your application will look as given below.
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=  So now the designing part is completed.
Java Coding for the Android Application:
= Click on app -> java -> com.example.exno4 -> MainActivity.

#® omal.X o 5 i el - - -
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RO #4 X000 AR ¢ Hém-Pen L ¥ TLES 7
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.
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= Then delete the code which is there and type the code as given below.
Code for MainActivity.java:

package com.example.exno4;

import android.app.Activity;

import android.graphics.Bitmap;

import android.graphics.Canvas;

import android.graphics.Color;

import android.graphics.Paint;

import android.graphics.drawable.BitmapDrawable;
import android.os.Bundle;

import android.widget.ImageView;

public class MainActivity extends Activity
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{
@Override

public void onCreate(Bundle savedInstanceState)
{
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

//Creating a Bitmap
Bitmap bg = Bitmap.createBitmap(720, 1280, Bitmap.Config.ARGB_8888);

//Setting the Bitmap as background for the ImageView
ImageView i = (ImageView) findViewByld(R.id.imageView);
i.setBackgroundDrawable(new BitmapDrawable(bg));

/[Creating the Canvas Object
Canvas canvas = new Canvas(bg);

/[Creating the Paint Object and set its color & TextSize
Paint paint = new Paint();
paint.setColor(Color.BLUE);

paint.setTextSize(50);

/[To draw a Rectangle
canvas.drawText("Rectangle", 420, 150, paint);
canvas.drawRect(400, 200, 650, 700, paint);

/[To draw a Circle
canvas.drawText("Circle", 120, 150, paint);
canvas.drawCircle(200, 350, 150, paint);

/[To draw a Square
canvas.drawText("Square™, 120, 800, paint);
canvas.drawRect(50, 850, 350, 1150, paint);

/ITo draw a Line
canvas.drawText("'Line", 480, 800, paint);
canvas.drawLine(520, 850, 520, 1150, paint);
}
}

= So now the Coding part is also completed.
= Now run the application to see the output.

Output:
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Circle Rectangle

Square Line

Result:
Thus a Simple Android Application that draws basic Graphical Primitives on the screen is developed and
executed successfully.
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EXPERIMENT 09

Aim:

To develop a Simple Android Application that makes use of Database.
Procedure:

Creating a New project:

= Open Android Studio and then click on File -> New -> New project.

" ex.nol - [C:AUsers\devang\AndroidStudioProjects\ex.no.1] - Android Studio 1.4 sk
Edit View Navigate Code Analyze Refactor ild Run Tools VCS Window Help
New New Proj *: ¥ ﬁ- s“ E—ﬁ Q @ a 'i' 2 Q
1 Open... Import Project...
Reopen Project » Project from Version Control »
Close Project New Modl... m
=
9 Settings... Ctrl+Alt+S Import Module... ]
[ Project Structure... Crl+Alt+Shift+S Import Sample... ;
Other Settings » € JavaClass i
Import Settings... 3 Module O A =
Export Settings... ' Android resource file # L@
Kl Save Al Ctitvs | Android resource directory  ang exnol (14404) [DEAD] n g
5 Synchronize CtrivAltey | Bl File : . £
Invalidate Caches / Restart... [£1 Package egex Show only selected i ”
5 Print... [5| C++ Class >
Add to Favorites 4 B C/C++ Source File 5y
File Encoding [l C/C++ Header File 5
o
Line Separators » Image Asset =
=
Make File Read-onl 'w' Vector Asset
by El . oD0 ™3 Event Log [=] Gradle Console
Eqwessave Moce Smgleton n/a | n/a | Context: <nc context> i1 ;
= Then type the Application name as “ex.no.5" and click Next.
W Lreatw Now Soopect - - —— e —— . - ﬁ

H New Project

Configure your new project
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=  Then select the Minimum SDK as shown below and click Next.

) Cruwte New Proecs 0 - - ﬁ

M Target Android Devices

Select the form factors your app will run on
Diffesent plaefonmi may deqase sepacate SES
B Prcew and Tabsiet
Mrveraem S0¢ [ 2115 Andvoud £33 GrcreamSmndancti B
Lowser APt lwsels target mose Sevce, Bag Savw feaw festioe svmlable. By tangearng 49115
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Geogle Py Stcre
Help e chocse
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“ - - 1k 13 n
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(] Arcvod dente

=  Then select the Empty Activity and click Next.

W Crunte Mow Proect - ﬁ

H Add an activity to Mobile

o . H

N [N

B TET™

| Googhe Mazt Actrvty Logm Acthety Mustee/Detad Flaw Nengeton Dewaer Actrety Seabng Aoty

Lo [IEEEEN | cwee |

= Finally click Finish.
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A Customize the Activity

Constes 2 vew ety acorarty
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Empty Actinty

= It will take some time to build and load the project.

= After completion it will look as given below.

& o) gt e eeieins e e — Y=
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Designing layout for the Android Application:

= Click on app -> res -> layout -> activity_main.xml.
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Now click on Text as shown below.
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Then delete the code which is there and type the code as given below.

Code for Activity_main.xml:

<?xml version="1.0" encoding="utf-8"?>
<AbsoluteLayout xmlns:android="http://schemas.android.com/apk/res/android"
android:layout_width="match_parent"
android:layout_height="match_parent">
<TextView
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_x="50dp"
android:layout_y="20dp"
android:text="Student Details"
android:textSize="30sp" />
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<TextView
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_x="20dp"
android:layout_y="110dp"
android:text="Enter Rollno:"
android:textSize="20sp" />

<EditText
android:id="@+id/Rollno"
android:layout_width="150dp"
android:layout_height="wrap_content
android:layout x="175dp"
android:layout_y="100dp"
android:inputType="number"
android:textSize="20sp" />

<TextView
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_x="20dp"
android:layout_y="160dp"
android:text="Enter Name:"
android:textSize="20sp" />

<EditText
android:id="@+id/Name"
android:layout_width="150dp"
android:layout_height="wrap_content"
android:layout_x="175dp"
android:layout_y="150dp"
android:inputType="text"
android:textSize="20sp" />

<TextView
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_x="20dp"
android:layout_y="210dp"
android:text="Enter Marks:"
android:textSize="20sp" />

<EditText
android:id="@-+id/Marks"
android:layout_width="150dp"
android:layout_height="wrap_content"
android:layout_x="175dp"

Mobile Computing

BVUCOEP




android:layout_y="200dp"
android:inputType="number"
android:textSize="20sp" />

<Button
android:id="@-+id/Insert"
android:layout_width="150dp"
android:layout_height="wrap_content"
android:layout_x="25dp"
android:layout_y="300dp"
android:text="Insert"
android:textSize="30dp" />

<Button
android:id="@-+id/Delete"
android:layout_width="150dp"
android:layout_height="wrap_content"
android:layout_x="200dp"
android:layout_y="300dp"
android:text="Delete"
android:textSize="30dp" />

<Button
android:id="@+id/Update"
android:layout_width="150dp"
android:layout_height="wrap_content"
android:layout_x="25dp"
android:layout_y="400dp"
android:text="Update"
android:textSize="30dp" />

<Button
android:id="@+id/View"
android:layout_width="150dp"
android:layout_height="wrap_content"
android:layout_x="200dp"
android:layout_y="400dp"
android:text="View"
android:textSize="30dp" />

<Button
android:id="@+id/ViewAll"
android:layout_width="200dp"
android:layout_height="wrap_content"
android:layout_x="100dp"
android:layout_y="500dp"
android:text="View All"
android:textSize="30dp" />
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</AbsoluteLayout>

Now click on Design and your application will look as given below.
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= So now the designing part is completed.

Java Coding for the Android Application:
=  Click on app -> java -> com.example.exno5 -> MainActivity.
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Then delete the code which is there and type the code as given below.
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Code for MainActivity.java:
package com.example.exno5;

import android.app.Activity;

import android.app.AlertDialog.Builder;

import android.content.Context;

import android.database.Cursor;

import android.database.sqlite. SQLiteDatabase;
import android.os.Bundle;

import android.view.View;

import android.view.View.OnClickListener;
import android.widget.Button;

import android.widget.EditText;

public class MainActivity extends Activity implements OnClickListener
{
EditText Rollno,Name,Marks;
Button Insert,Delete,Update,View,ViewAll;
SQL.iteDatabase db;
/** Called when the activity is first created. */
@Override
public void onCreate(Bundle savedinstanceState)
{
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

Rollno=(EditText)findViewByld(R.id.RolIno);
Name=(EditText)findViewByld(R.id.Name);
Marks=(EditText)findViewByld(R.id.Marks);
Insert=(Button)findViewByld(R.id.Insert);
Delete=(Button)findViewByld(R.id.Delete);
Update=(Button)findViewByld(R.id.Update);
View=(Button)findViewByld(R.id.View);
ViewAll=(Button)findViewByld(R.id.ViewAll);

Insert.setOnClickListener(this);
Delete.setOnClickListener(this);
Update.setOnClickListener(this);
View.setOnClickListener(this);
ViewAll.setOnClickListener(this);

/I Creating database and table
db=openOrCreateDatabase("StudentDB", Context. MODE_PRIVATE, null);
db.execSQL("CREATE TABLE IF NOT EXISTS student(rolino VARCHAR,name VARCHAR,marks VARCHAK );");

¥

public void onClick(View view)

{
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I/ Inserting a record to the Student table
if(view==Insert)
{
Il Checking for empty fields
if(Rollno.getText().toString().trim().length()==0||
Name.getText().toString().trim().length()==0]||
Marks.getText().toString().trim().length()==0)
{
showMessage("Error", "Please enter all values™);
return;
}
db.execSQL("INSERT INTO student VALUES("'+Rollno.getText()+","'+Name.getText()+
" "+Marks.getText()+");");
showMessage("'Success”, "Record added");
clearText();
}
// Deleting a record from the Student table
if(view==Delete)
{
/I Checking for empty roll number
if(Rollno.getText().toString().trim().length()==0)
{
showMessage("Error”, "Please enter Rollno™);
return;

}

Cursor c=db.rawQuery("SELECT * FROM student WHERE rollno=""+Rollno.getText()+"", null);

if(c.moveToFirst())

{
db.execSQL("DELETE FROM student WHERE rollno=""+Rollno.getText()+"");
showMessage("'Success”, "Record Deleted");

}

else

{

showMessage("Error”, "Invalid Rollno™);

}

clearText();
}
// Updating a record in the Student table
if(view==Update)
{
Il Checking for empty roll number
if(Rollno.getText().toString().trim().length()==0)
{
showMessage("Error”, "Please enter Rollno");
return;

}
Cursor c=db.rawQuery("SELECT * FROM student WHERE rollno=""+Rollno.getText()+""

if(c.moveToFirst()) {
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db.execSQL("UPDATE student SET name=""'+ Name.getText() + "",marks="" + Marks.getText() +
" WHERE rollno=""+Rollno.getText()+"");
showMessage("'Success”, "Record Modified");
}
else {
showMessage("Error”, "Invalid Rollno");

}

clearText();
}
/I Display a record from the Student table
if(view==View)
{
/I Checking for empty roll number
if(Rollno.getText().toString().trim().length()==0)
{
showMessage("'Error", "Please enter Rollno");
return;
}
Cursor c=db.rawQuery("SELECT * FROM student WHERE rollno=""+RolIno.getText()+"", null);
if(c.moveToFirst())
{
Name.setText(c.getString(1));
Marks.setText(c.getString(2));
}
else
{
showMessage("Error”, "Invalid Rollno");
clearText();
}

}
// Displaying all the records

if(view==ViewAll)
{
Cursor c=db.rawQuery("SELECT * FROM student”, null);
if(c.getCount()==0)
{
showMessage("Error”, "No records found");
return;
}
StringBuffer buffer=new StringBuffer();
while(c.moveToNext())
{
buffer.append("Rollno: "+c.getString(0)+"\n");
buffer.append("Name: "+c.getString(1)+"\n");
buffer.append("Marks: "+c.getString(2)+"\n\n");
}
showMessage("Student Details", buffer.toString());

}
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}

public void showMessage(String title,String message)
{
Builder builder=new Builder(this);
builder.setCancelable(true);
builder.setTitle(title);
builder.setMessage(message);
builder.show();

}

public void clearText()

{
Rollno.setText(""");
Name.setText("");
Marks.setText("");
Rollno.requestFocus();

}

}

= So now the Coding part is also completed.
= Now run the application to see the output.

Output:

Student Details

Enter Rollno:
Enter Name:

Enter Marks:

UPDATE VIEW

VIEW ALL

Student Details

Rollno: 2

Marks: 80

Result:

Student Details

Rollno: 1
Name: devang
Marks: 95

Success Error Rollno: 2
Name: akhil
Record added No records found Marks: 90
INSERT DELETE

Rollno: 3
Name: abdul
Marks: 80

Student Details

Enter Rollno: 1

Enter Name: avinash

Name: akhil Enter Marks: 95

Marks: 90 Success B

Rollno: 3 Record Modified

Name: abdul INSERT DELETE

UPDATE VIEW

VIEW ALL

[m}

Thus a Simple Android Application that makes use of Database is developed and executed successfully.
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EXPERIMENT 10

Aim:

To develop a Android Application that creates Alarm Clock.
Procedure:

Creating a New project:

= Open Android Studio and then click on File -> New -> New project.

® exno.l - [CAUsers\devang\AndroidStudioProjects\ex.no.1] - Android Studio 1.4 = | B |t
Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
New New Project... ¥ B* %“ ETE Q E ﬁ -i'u ? Q
3 Open... Import Project...
Reopen Project » Project from Version Control » . ..
Close Project New Module... m
9 Settings... Ctrl+Alt+S  Import Module... g
[ Project Structure... Ctrl+Alt+Shift+S Import Sample... ;
Other Settings » © Java Class i
Import Settings... 3 Module e : ; =
Export Settings... & Android resource file - L

appein (3

15l Save All Ciries 1 Android resource directory  3ng exnol (14404) [DEAD]
@) Synchronize CtrisAlsy [l File
Invalidate Caches / Restart... [1 Package ) Regex | Show only selected |

= &
B Print... 'L_S,LJ C++ Class »
Add to Favorites » & C/C++ Source File g
File Encoding [i C/C++ Header File :Zl
Line Separators » Image Asset =
™
Make File Read-onl ' Vector Asset
iy @ s oD0 3 Eventlog (=] Gradle Console
Eowes Save Mode Singleton n/a | n/a | Context: <nc context> -] E
1 1 <« " H
» Then type the Application name as “ex.no.11”" and click Next.
e el

# Cruer M Progest

Configure your new project

Apphcation name | enratl] |
Company Do | devang earrgle com
Packageomme oo st ey =

Paagext ocaen CAlsery deverg Asdhor dStud ePropectes so 11

The apgheocn rarve fir wnion apge berprs ah a0 appocate leter

EZN | o |

= Then select the Minimum SDK as shown below and click Next.
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= Finally click Finish.
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= It will take some time to build and load the project.

= After completion it will look as given below.
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Creating Second Activity for the Android Application:

» Click on File -> New -> Activity -> Empty Activity.
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= Type the Activity Name as AlarmReceiver and click Finish button.

® Now Asdud actity = TRE T e R e - —_

H Customize the Activity
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= Thus Second Activity For the application is created.
Designing layout for the Android Application:

= Click on app -> res -> layout -> activity_main.xml.
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= Now click on Text as shown below.
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Then delete the code which is there and type the code as given below.

Code for Activity_main.xml:

<?xml version="1.0" encoding="utf-8"?>

<LinearLayout xmins:android="http://schemas.android.com/apk/res/android
android:layout_width="match_parent"
android:layout_height="match_parent"
android:orientation="vertical">

<TimePicker
android:id="@-+id/timePicker"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_gravity="center" />

<ToggleButton
android:id="@-+id/toggleButton"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_gravity="center"
android:layout_margin="20dp"
android:checked="false"
android:onClick="0OnToggleClicked" />

</LinearLayout>

Now click on Design and your application will look as given below.
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= So now the designing part is completed.
Changes in Manifest for the Android Application:

= Click on app -> manifests -> AndroidManifest.xml
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= Now change the activity tag to receiver tag in the AndroidManifest.xml file as shown below
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Code for AndroidManifest.xml:

<?xml version="1.0" encoding="utf-8"?>
<manifest xmlIns:android="http://schemas.android.com/apk/res/android"
package="com.example.exnoll" >
<application
android:allowBackup="true"
android:icon="@mipmap/ic_launcher"
android:label="@string/app_name"
android:supportsRtl="true"
android:theme="@style/AppTheme" >
<activity android:name=".MainActivity" >
<intent-filter>
<action android:name="android.intent.action.MAIN" />
<category android:name="android.intent.category.LAUNCHER" />
</intent-filter>
</activity>
<receiver android:name=".AlarmReceiver" >
</receiver>
</application>
</manifest>

= S0 now the changes are done in the Manifest.
Java Coding for the Android Application:

Java Coding for Main Activity:

= Click on app -> java -> com.example.exnoll -> MainActivity.
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= Then delete the code which is there and type the code as given below.

Code for MainActivity.java:

package com.example.exnoll;

import android.app.AlarmManager;

import android.app.Pendinglntent;

import android.content.Intent;

import android.os.Bundle;

import android.support.v7.app.AppCompatActivity;
import android.view.View;

import android.widget. TimePicker;

import android.widget. Toast;

import android.widget. ToggleButton;

import java.util.Calendar;

public class MainActivity extends AppCompatActivity
{

TimePicker alarmTimePicker;

Pendinglntent pendinglntent;

AlarmManager alarmManager;

@Override
protected void onCreate(Bundle savedInstanceState)

{

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
alarmTimePicker = (TimePicker) findViewByld(R.id.timePicker);
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alarmManager = (AlarmManager) getSystemService(ALARM_SERVICE);

}
public void OnToggleClicked(View view)

{

long time;

if (((ToggleButton) view).isChecked())

{
Toast.makeText(MainActivity.this, "ALARM ON", Toast. LENGTH_SHORT).show();
Calendar calendar = Calendar.getInstance();
calendar.set(Calendar. HOUR_OF DAY, alarmTimePicker.getCurrentHour());
calendar.set(Calendar. MINUTE, alarmTimePicker.getCurrentMinute());
Intent intent = new Intent(this, AlarmReceiver.class);
pendinglntent = Pendinglntent.getBroadcast(this, 0, intent, 0);

time=(calendar.getTimelnMillis()-(calendar.getTimelnMillis()%60000));
if(System.currentTimeMillis()>time)
{
if (calendar. AM_PM == 0)
time = time + (1000*60*60*12);
else
time = time + (1000*60*60*24);
¥
alarmManager.setRepeating(AlarmManager. RTC_WAKEUP, time, 10000, pendinglintent);

}

else

{

alarmManager.cancel(pendinglntent);
Toast.makeText(MainActivity.this, "ALARM OFF", Toast. LENGTH_SHORT).show();

}
¥
¥

= So now the Coding part of Main Activity is completed.
Java Coding for Alarm Receiver:

= Click on app -> java -> com.example.exnoll -> AlarmReceiver.
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= Then delete the code which is there and type the code as given below.

Code for AlarmReceiver.java:

package com.example.exnoll;

import android.content.BroadcastReceiver;
import android.content.Context;

import android.content.Intent;

import android.media.Ringtone;

import android.media.RingtoneManager;
import android.net.Uri;

import android.widget. Toast;

public class AlarmReceiver extends BroadcastReceiver

{
@Override

public void onReceive(Context context, Intent intent)

{

———rere e

Toast.makeText(context, "Alarm! Wake up! Wake up!", Toast LENGTH_LONG).show();
Uri alarmUri = RingtoneManager.getDefaultUri(RingtoneManager. TYPE_ALARM);

if (alarmUri == null)

{
alarmUri = RingtoneManager.getDefaultUri(RingtoneManager. TYPE_NOTIFICATION);
}
Ringtone ringtone = RingtoneManager.getRingtone(context, alarmUri);
ringtone.play();
¥
¥

= So now the Coding part of Alarm Receiver is also completed.
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= Now run the application to see the output.

Output:
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Result:

Thus Android Application that creates Alarm Clock is developed and executed successfully.
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EXPERIMENT 11

Aim:

To develop a Android Application that creates an alert upon receiving a message.
Procedure:

Creating a New project:

= Open Android Studio and then click on File -> New -> New project.

#® exno.l - [C\Users\devang\AndroidStudioProjects\ex.no.1] - Android Studio 1.4 [E=Re >

Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
¥ b ¥E $RE® ?2Q
7 Open... Import Project...
Reopen Project »  Project from Version Control »
Close Project New Module... m
=
¥ Settings... Ctrl+Alt+S Import Module... g
[ Project Structure... Ctrl+Alt+Shift+S Import Sample... ;
Other Settings » € JavaClass ﬁ-
Import Settings... 3 Module s e Ly =
Export Settings... & Android resource file B Lo
K saveAll Ctrl+S [ Android resource directory ang.exnol (14404) [DEAD] ' g
D Synchronize CtrleAltsy | B File : g
Invalidate Caches / Restart... [ Package Regex | Show only selected ; +
5 Print... LI—E\.J C++ Class b
Add to Favorites ) & C/C++ Source File g
File Encoding [ C/C++ HeaderFile ;
7 o
Line Separators » Image Asset 2
Make File Read-only 1" Vector Asset
A s oDo 3 Eventlog (=] Gradle Console
Eowes SmyeMode Singleon n/a | n/a | Context: <nc context> a8

» Then type the Application name as “ex.no.10” and click Next.
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= Then select the Minimum SDK as shown below and click Next.
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» Then select the Empty Activity and click Next.
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» Finally click Finish.
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= It will take some time to build and load the project.

= After completion it will look as given below.
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Creating Second Activity for the Android Application:

= Click on File -> New -> Activity -> Empty Activity.
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= Type the Activity Name as SecondActivity and click Finish button.
R—— el

9 Now Androdt Aty ™ TR

A' Customize the Activity

Crestes » new ety Mty

. Actity N | Seccrdictnty
Gernnste Layoaz Tile
Laprt Name | scinity_secons
(7] Lawncher Actwiy

Package name | com earrgle devmgonel n

Somgay Activeny

| The rarve of the actn €y Cbiss to Creste

= Thus Second Activity For the application is created.
Designing layout for the Android Application:

= Click on app -> res -> layout -> activity_main.xml.
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* Now click on Text as shown below.
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= Then delete the code which is there and type the code as given below.

Code for Activity_main.xml:

<?xml version="1.0" encoding="utf-8"?>

<LinearLayout xmlIns:android="http://schemas.android.com/apk/res/android"
android:layout_width="match_parent"
android:layout_height="match_parent"
android:layout_margin="10dp"
android:orientation="vertical">

<TextView
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android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:text="Message"
android:textSize="30sp" />

<EditText
android:id="@-+id/editText"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:singleLine="true"
android:textSize="30sp" />

<Button
android:id="@-+id/button"
android:layout_width="wrap_content"
android:layout_height="wrap_content"
android:layout_margin="30dp"
android:layout_gravity="center"
android:text="Notify"
android:textSize="30sp"/>

</LinearLayout>
» Now click on Design and your application will look as given below.
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= So now the designing part is completed.
Java Coding for the Android Application:

= Click on app -> java -> com.example.exno10 -> MainActivity.
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= Then delete the code which is there and type the code as given below.

Code for MainActivity.java:

package com.example.exnol0;

import android.app.Notification;

import android.app.NotificationManager;

import android.app.PendingIntent; import
android.content.Intent;

import android.os.Bundle;

import android.support.v7.app.AppCompatActivity;
import android.view.View;

import android.widget.Button;

import android.widget.EditText;

public class MainActivity extends AppCompatActivity
{
Button notify;
EditText e;
@Override
protected void onCreate(Bundle savedInstanceState)
{
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

notify= (Button) findViewByld(R.id.button);
e= (EditText) findViewByld(R.id.editText);
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notify.setOnClickListener(new View.OnClickListener()
{
@Override
public void onClick(View v)
{
Intent intent = new Intent(MainActivity.this, SecondActivity.class);
PendinglIntent pending = PendingIntent.getActivity(MainActivity.this, 0, intent, 0);
Notification noti = new Notification.Builder(MainActivity.this).setContentTitle("New Message™)
.setContentText(e.getText().toString()).setSmalllcon(R.mipmap.ic_launcher).setContentintent(pending).build();
NotificationManager manager = (NotificationManager) getSystemService(NOTIFICATION_SERVICE);
noti.flags |= Notification.FLAG_AUTO_CANCEL;
manager.notify(0, noti);
}
b
}
}

= So now the Coding part is also completed.
= Now run the application to see the output.

Output:
w 44das5is 1241 vddass 1241 & Fddasmazall o4 4 @44 8560
ex.no.10 ex.no.10 Wednesday, March 16 e
New Message 241 AM
Message Message Message @ how r u?
how r u? how ru?
NOTIFY NOTIFY NOTIFY

4
12 3 45 6 7 8 90
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Result:

Thus Android Application that creates an alert upon receiving a message is developed and
executed successfully.
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